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O Introduction

CellDesigner's major features:

* Biochemical, Gene Regulatory Networks Modeling with GUI
* Visual Representation of Biochemical Semantics

¢ Detailed Description of State Transition of Protein

* SBML (=Systems Biology Markup Language) Compliant

e Linkage to SBW Powered Simulator Modules

e Extreme Portability as a JAVA Application

CellDesigner 2.5 New Features:

On top of the following CellDesigner 2.0, 2.1, and 2.2 features, CellDesigner 2.5 now
supports:

* Integrate SBML ODE Solver with the Control Panel for Simulation
* Check http://celldesigner.org for details.
e Database Connection to iHOP (=Information Hyperlinked over Proteins)

[CellDesigner 2.0, 2.1 and 2.2 Major Features]

* Intuitive User Interface

* Display in Color (Species and Compartments)

e Support Block Diagram (*Proto-type)
» Extract the control relationship between Proteins from the pathway diagram.
» Describe and Verify the Modifications/Activations Logic.

e Extensive Notes Description (to Compartment, Species, Reaction, Protein)

e Support New Symbols
» Relationship between elements: unknown catalysis, unknown inhibition.
» Residue Modification: Hydroxylated

e SBML Compliant (Level 2 Version 1)

* Qutput Lists to CSV format.

* Output Images in PNG format.

e SBW 2.0 support

* Database Connections (PubMed, DBGET, SGD)

¢ QOutput images to SVG format

* Bugfix


http://celldesigner.org/
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1 Installation and Startup

1.1 Operating Environment

The current version of CellDesigner requires Java2 Runtime Environment (JRE1.4.2
or later) on Windows (98 or later), MacOSX (10.3 or later), and Linux with X Window
System (Fedora Core 4 or later).

On MacOSX, Java 1.4.2_05 or later is required. On Linux platform, due to the version
of native libraries, Fedora Core 4 or later is recommended; some problems will arise if
you use other than these.

The current version of CellDesigner requires Java2 Runtime Environment (JRE1.4.2
or later). The installer includes JRE (Java Runtime Environment), so you do not have
to install Java before your installation.

If SBW and its modules have already been installed, these modules are available.
Especially time evolving simulation of editing models can be performed.

1.2 Install SBW and SBW Modules

If you are interested in time evolving simulation and analysis on biochemical
networks, we recommend you to install the Systems Biology Workbench (SBW) and
SBW-powered software before you install CellDesigner (*).

Please check http://sbw.kgi.edu/ and download the software from Download
section.

To install SBW and SBW-powered software, follow their installation instructions.

If you would like to use CellDesigner alone right now, you can postpone this step until
you need simulation and/or analysis.

(*) As of July, 2005, SBW 2.3.1a is available on Windows. SBW 2.3.0 is available for Mac
OS X and Linux.
For details on SBW 2.3x information:
http://sys-bio.org/research/sbwintro.htm

1.3 Install CellDesigner

The current release is distributed in archived installer package for each operating
system.

Windows: CDInstall_2 5 win.exe
MacOSX: CDInstall_2 5 mac.zip
Linux: CDInstall_2 5 linux.bin

While J2RE is required for CellDesigner to run, the installers include it. Therefore,

4



CellDesigner™ Startup Guide

you do not need to download or install J2RE.

Windows:
1. Doubleclick CDInstall 2 5 win.exe.

The installer window should open, and follow the message therein.
2. Follow the instruction of the installer.

MacOSX:

1. Double click CDInstall_2_5 mac.zip.
The compressed installer should be recognized by Stuffit Expander and should
automatically be expanded to CDInstall_2_5.

2. Then double click it.
The installer window should open, and follow the message therein.

Linux:
1. Open a shell and, cd to the directory where you downloaded the installer.
2. At the prompt type: sh ./CDInstall_2 5 linux.bin.

The installer window should open, and follow the message therein.

Note: In case you have installed SBW 2.3.x and you encounter an error while
installing CellDesigner, there might be a possibility that the C++ Broker is up which
prevents CellDesigner to start. Please try to kill the broker using the Task Manager,
or restart your system before you resume the CellDesigner installation.

[Installed File Images]
After installation finished, you would see the following directories/files in the
installation directory (Cel IDesigner2.5 by default).

+00README . txt

|

+CellDesigner2.5 executable application module (*for Mac: Cel IDesigner)
+simulation._properties

+documents/
| +startup_guide25.pdf  this document
| +controlpanel25._pdf quick tutorial for control panel

+exec/

| +celldesigner.jar library for CellDesigner application

|

+jre (1.4.2_08) *(Windows, Linux only)

|

+lib

| +batik/

| +batik._jar SVG toolkit by the Apache Software Foundation

| +browserlauncher/

| +browserlauncher.jar library web browser launcher by Eric Albert
| +jai/
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+jai codec.jar library for Advanced Imaging by Sun Microsystems, Inc.
+jail core.jar

+mlibwrapper jai.jar

+jfreechart/

+jfreechart-1.0.0-pre2.jar library for generating charts by David Gilbert
+mrjadapter/

+MRJAdapter.jar library for MacOSX feature by Steve Roy, Software Design
+sbw/

+SBWCore.jar library for connecting SBW by KGI (initially by ERATO)
+xerces/

| +xercesImpl.jar XML library by the Apache Software Foundation
+xml-apis.jar XML-API library by the Apache Software Foundation

+licenses/

+batik/

+LICENSE

+jai/

+LICENSE_j al.txt
+jfreechart/
+license-LGPL. txt
+mrjadapter/
+1gpl.txt
+xerces/

+LICENCE
+LICENCE-DOM.html
+LICENCE-SAX.html

+samples/
| +components.xml sample for various components
| +M-Phase.xml sample for model editing
| +M-Phase2.xml sample for model editing
| +MAPK.xml sample for simulation provided by SBML ODE Solver
| +simulation.xml sample for simulation
| +test-levell.xml sample for SBML level 1 document
| +test-level2.xml sample for SBML level 2 document
+database.xml sample for database connections

+Uninstall CellDesigner uninstaller module directory

1.4 Startup CellDesigner

Windows:
1. Double click shortcut icon <3 Cel IDesi gner2.5 in your desktop.

Or double click CellDesigner2.5.exe in the directory where you chose to
install (C:¥Program Files¥CellDesigner2.5 by default).

MacOSX:

1. Click 93 icon for CelIDesigner in dock.
Or double click CellDesigner in the folder you chose to install
(Application/CellDesigner2.5 in you home directory by default).
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Linux:

1. On a shell, ecd to the directory where you chose to create links and
type ./runCellDesigner2.5.

Or type -/runCellDesigner2.5 after cd to the directory where you chose to
install (Cel IDesigner2.5 in you home directory by default).

1.5 CellDesigner Screen and Navigation

!_]EellDesigner _10] x|
File Edit Component “iew Dstabase Simulafion  Window  SEVY Preference  Help Menu

JDUDD@DDQDOQQJ—»—&-&---»—O----D—« ----- I W i TR L T R

[ —
@@ ra l—-’,;ll | = Tool Bars —
= M.Ddzlompadmems (:) (:}eciesl Prmeinsl Readionsl Comg ‘l 4
# Species Edlit
# Reactions o ]
type |posrt|onT...| id I Hame
List Area
Tree Area Draw Area
e, | [}

e it Niotes | [Exit Protein pictes |

Notes Area
CellDesigner consists of four areas as shown above:
Draw Area: To draw a model.
List Area: to display and edit the list of the components, functions
....of a model
Notes Area To display and edit the notes of the component
Tree Area: Displays all the list of the components in the tree structure.

Change the area size:
* The size of the area can be changed by dragging the border lines.
* To maximize the area, click the triangle icons on the borders.

Customize Tool bar:

¢ Each group of the icons can be detached from the Tool Bar.

e It can also move to the left side of the screen by dragging the handle to the left
boundaries.
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2 Quick Tutorial of Model Building

This section is for beginners, and describes how to edit and what kind of model to be edited
with CellDesigner in brief.

Take a sample file “M-Phase .xml”* to open in the CellDesigner. This model contains most
of the essential CellDesigner's expression of biochemical networks.

2.1 Open a File:

1. Select File — Open in main menu bar to open M-Phase . xml in samples directory.
A graphical network model is displayed on the Draw Area.

@ celibesigner =101 x|

Fie Edi Comporent View Deishase Simdstion Window SBIW FPreference Help

EeE@fed o cBRaEafER|ITEEERRE | EHEAB|ReR e | oaonagosccocoe

|4 0o B A e (B0 g 2= | =

Jdeel M-Phase.xm | Species | proteins | Reactions | Compartmerts | Parameters | Functiort <] »

| Species — Edit

] Reactions

type [postont..| nane compart... | quantty ..
PROTEN |nside  [s3 |cyclnB et [amourt |t
PROTEN |nsice |35 |pP2a et lamaurt |t
PROTEN |nsice |36 |sinase et lamaurt |t
PROTEN nesce  |s7  [cak 1 lamaurt |t
PROTEN |nede  [s10 w1 1 lamaurt |t
PROTEN |nside  |s11  |Lamin 1 lomaurt |t
PHENOTY..|nside 512 |M-Phase o1 lomaurt |t
PROTEN |nside  |s21  |Lamin o1 lomourt |t
PROTEN |nside  s4 |cdc2s o1 lsmourt |t
PROTEN |nsids  [s8 Mkt o1 [amourt |t
PROTEN |nsids  [s8 [weet o1 [amourt |t
PROTEN |nside  s22 |cdo2s o1 [amourt ¢
PROTEN |nsids  [s24 [wiest o1 [amourt |t
PROTEN |nside  [s25 ikt et [amourt |t
DEGRADED|nside 526 |a33_degraded o [amourt |t
PROTEN |nside sz |cde2 et [amourt |t
HETERO_.|nside 327 |Complex(CyeliB,... el [Amourt i
HETERO_..|nside 328 |Complex(CyelrB,... c1 [Amourt o
HETERO_..|nside 529 |Complex(CyelrB,... c1 lamourt o
HETERO_..|nside 530 |Complex(CyelrB,... [e1 [amourt o
1| | _’u
Edithotes | | Edit Protein Hetes:
Gde25 (]
<«
| Grid Snap OFF

2. Drag the borders (left or right) of the draw area to change the area size

Functiol

- i

2.2 Select an Item:

3. Confirm "select/move" icon is highlighted (in select/move mode).

I IE ‘E' DD':' i If not, click the icon.

4. Select shapes (not arrows, not rounding overall; called Species in SBML),
and see what are highlighted.
[Ans. The shapes and linked arrows.]
5. Select arrows (called Reaction in SBML),
and see what are highlighted.
[Ans. The arrows and attached arrows.]
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2.3 Move / Delete an ltem:

The objects highlighted in magenta are influenced by "move" and "delete" actions to
the selected object.

6. Drag and move the Species,
7. Delete the Species and Reactions by using Backspace and / or Delete keys.

2.4 Compartment:

The other shape rounding overall is called Compartment in SBML.
8. Click the Compartment (click inside without any other shapes),
and see what are and how highlighted.
[Ans. The Compartment highlighted in magenta, Species inside shadowed]
A Compartment can place Species and other Compartments inside.
9. Drag and move the Compartment, and confirm Species inside are on it.

2.5 Undo / Redo:

You can "undo" all of the past actions by [CTRL]-z, and then "redo" after undo by
[CTRL]-y before saving the model. Try

10. Undo by [CTRL]-z,

11. Redo by [CTRL]-y.

2.6 Change the size of an item:

When selecting the Species and Reactions, you can see small squares appear. These
are handles to change the size of Species and to bend the arrows of Reactions.
12. Drag the small squares and move.

2.7 Species and Reactions:

The Species represents, for example, proteins and other molecules in biochemical
networks and genes in gene regulatory networks.

The Reaction represents, for example, biochemical reactions literally, interaction
between proteins, and regulatory relations between genes.

The biochemical and genetic meanings of Species and Reactions are distinguished by
their symbols. The list of all symbols that can be drawn using CellDesigner and their
meanings are described in [Section 6 “Symbols and Expressions].
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Graphic notation space

(- N

Il\L.k::t:u‘ni:nﬂr11‘|'|n=.=r1l o1

Symbaolic process expression of the CellDesigner

To change the symbols of Species / Reactions:

If you double click Species and Reactions, the dialog box will appear to alter its type.
13. Double click a Species (especially decorated one),
click and change anything in the dialog box, and then, see what is changed after
click "Apply" button.
14. Double click a Species (especially decorated one),

click and change anything in the dialog box, and then, see what is changed after
click "Reset" button.

2.8 Change the Shape of Compartments:

A Compartment represents a generic bounded container, such as, cell, intracellular
compartment. Thus, notational change is only in visual, meaningless to semantics of
biochemical and gene networks.

To change the shape of Compartment:

15. Select the Compartment,
16. Select Edit—Change to OVAL,
17. Then select Edit—Change to SQUARE.

2.9 Activate a Species:

18. Select Species and type "a" on keyboard, and see how it changes.

[Ans. The Species are wrapped by dashed line.]
The dashed line has somewhat ambiguous meanings, indicating that Species are
“active” without referring their targets.
> See also [Section 6.1.1 “Symbols and Expressions” “Basic Symbols”].

10
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2.10 Create New Species, Reactions, and Compartment:

(From this part, use the icons other than "select / move".)
19. If you want to create new Species, Reaction, or Compartment, use icons on the
tool bar.

New Species:

20. Select an icon (placed in the tool bar) by click and then click a point on the canvas
(draw area), where you want to place the new.

OOz o 0 O -

New Compartment:

21. Select an icon from the compartment bar (as shown below) by click and then drag
a point to another on the canvas until the new becomes suitable size.

B f3 2 =| | =

New Reaction:

22. Select an icon with an arrow on it,
| — _l':u"n_" S oy Y S 1 —t \H"\-\. _.-". ).‘. _cc _H.<: i e e g b

and then link Species to Species/Reaction on canvas.

(in details) Click Species on canvas you want to link by the Reaction in the order
of start-point(s) to end-point(s). Reactions themselves are allowed to be endpoints
of other Reactions.

There are some buttons with actions not mentioned above.
23. Try the followings after select the buttons and see what happens.

A) Create heterodimer: click several Species.
B) Release heterodimer: click several Species.
C) Homodimer formation:  click several Species.
D) Degradation: click several Species.
E) Add reactant: click a Species and then a Reaction.
F) Add product: click a Reaction and then a Species.

2.11 Add Notes to the Components:

You can add a note to any component (Species, Reaction, Compartment, and Protein).
The notes should be written in XHTML format. For details on XHTML tags and
attributes, please check the XHTML 1.0 specification provided at
http//www.w3.org/TR/xhtml1/

You can enter PubMed ID in the notes, and directly link to the relevant reference.
> See also [Section 2.14 “Connect to Database”].

11
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To add a note to the component:

24.

25.

26.

27.

Select the target component (any Species, Reaction, Compartment, and Protein).
The current notes of the target component are displayed in the Notes window in
the right-bottom corner of the window.

Clle [Edlt Notes] button. [ species Notes (id=s1; untitled.xmi) x|

=htinl xplnz="Hitp: s w3 argil 9990ktml=

Species Notes dialog will pop-up. <cortys

Note: If the target is a protein, you can also
select [Edit Protein Notes].

Type the text you want to add as the notes to e

=/httnl=

the component. o
The text should be in XHTML format. ——

Then Click [OK] to close the dialog

The notes you have just added will
Eait Notes | _Eat Protein ntes | | be displayed in the notes window.

Cpecies (id=s1, name=sl; untitled.xml)
pripecies Notes: For details, <a
href="http:/fwww. cel ldesizner. ore”rcheck hered/ax</p>

Frotein (id=pl, name=sl)
Frotein hNotes:

2.12 Export Image:

You can export the image of the model to either .PNG, .JPEG or .SVG format.

28.
29.

Select [File] — [Export Image...]
Then specify the name and the file format.
The image saved here is the same as displayed on screen.

2.13 Export List to CSV file:

You can export the contents of the list into .CSV file format. This is useful when you
want to check all the items specified in the model.

30.
31.

32.

Select the [Species] tab in the list window.

Select [File] — [Export List to CSV...].

The file name is automatically specified as “M-Phase_species.csv” in the Save
dialog.

Click [Save] to save the CSV file.

You may use other applications to check the contents of the CSV file.

12
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2.14 Connect to Databases

You can connect to the databases from Species name or ID specified in the notes of the
components. Currently we support the connections to the following databases:

* DBGET (a simple database retrieval system for a diverse range of molecular biology
databases.)

* SGD (Saacharomyces Genome Database)

* iHOP (Information Hyperlinked over Proteins)

* PubMed

Connect to the databases from Species Name:

33. Select the component (Species, Reaction or Compartment)
then select [Database] -> [Connect to SGDI, [Connect to DBGET] or [Connect to
iHOP].
According to the name of the Species, the web browser will pop up and open the
relevant page.

Note: In case of DBGET, search is conducted according to the format of the name. If
the name is written as "2.1.3.1", "EC2.1.3.1", "EC: 2.1.3.1", and "EC 2.1.3.1" for EC
number, while the name start with "C", "C00010", "C 00010", "C: 00010" , search for
compound ID.

Connect to PubMed via the ID written in the Notes of the components:

34. Specify the PubMed ID in the notes of Species, Reaction, or Compartment as
follows;
PMID: 12345 PMID: 67890

35. Select the component (Species, Reaction or Compartment) then [Database] ->
[Connect to PubMed]

FHAE EEE B BRIOW oD ARTH
e ke GEW Pebeerce BB LD [] st rim b o v o e Vg e o= e e et g B <Al e V0 %]

- i)
Natiomal
Pu b&'&]ed i
960 tis ra— ] vy

00 ra “-I l-i-u'.'.*' a4
OBGET 3134 3 - Prevestocien [ iisione [ Capoaar
B rumbar S By [ o e _|s,....|n _J|s T |

Fupre il hi-n-o-»lnlJJ.qn_nug;zn
EC2113
EC 2135
DBGET
L CoXn 03050
Co00

THADTHN
!

AR | Bedew 0

i Call Biod 2001 e 181 53031020
Integrin-mediated adhesion regulates ERK nuclear
trunsloc tion and phosphorylation of Elke1
Apln AE, Stewart 5A, Auscian RE, Julsmne AL

Etm mant ofl’-‘m rmacalegy. Seheol of Medicing. 'mn‘r\ of Nerth
el b Claral bt St 27560 (R4
T

Pasction (igiral, rassss fabasssen. sl )
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3 Edit Proteins

In this section, how to edit proteins with modification sites, such as "Cdc2" in the sample
“M-Phase.xml”, is being described.

With CellDesigner, you can edit symbols of proteins with modification residues on a
network diagram, and hence, describe detailed state transitions between Species of an
identical protein with different modifications. The structure of modification residues,
states, and state transitions of proteins are also stored in SBML Level 2 format with
CellDesigner’s extended tags.

The model M-Phase.xml, you see, describes state transition of "Cdc2," where there are five
"Cdc2"s. The five represent different Species, while essentially the same protein.
Therefore, CellDesigner should handle data structure describing each protein in a model,
so that several protein-type Species could have references to the same protein data. This
data structure is called Protein.

14
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3.1 Check and Change Protein Property

You can see this Protein data by selecting the Protein tab in the List Area.

If you cannot see the Protein tab, click on the right arrow in the upper right corner of

the List Area, and adjust the size of the List window appropriately.
1. Select "Cdc2" in the list and click Edit button.

The Protein dialog will appear. In this dialog, EEZEEEEEEEE

you can edit several properties of Protein,  name Jcaca]

name, class, and residues (add, edit, and  ®sss Joengrc |

delete). SR

acldl.. — e

Changes in this dialog are reflected to all Species — gw %
referring to this Protein. e
The changes are also reflected to Heterodimers et block disarar. [
(complex of several Species) including such
Species, as you expect. e |[ oo |

3.2 Residue of Proteins

The residues of proteins can be added in the Protein dialog, but the modification of the
residue status (such as phosphorylated, etc.) is NOT maintained as Protein’s property,

but as Species’ identity.

1. Therefore, modifications are edited by =

2. Double-click Species in “select/move” mode. e
In the dialog appeared, you can change the ™= Eisemeianen
modification types. e m _
Note: You cannot add, edit, or delete modification | wer = =
residues in “Change Species Identity” dialog. o Lo

A Protein referred by the Species can be selected in the .

“Protein” pulldown in the dialog. If you want new +‘ P

protein, not listed in the “Protein” pulldown, select

[New Protein] listed at the last and you can edit the rewes=e [ |

new Protein here. Only in this case you can add, edit, [z | et | concel |

and delete residues.
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3.3 Block Diagram (*Proto-type)

Block diagram gives a summary view of interactions with respect to a specific Species
(especially Protein) and relation between its modification and activity as enzyme.
Using this block diagram editor, complex relations between Proteins can be
understood at a glance and the relation between modification states enzymic activity
can easily be constructed.

Note: The editor is still prototype and user interface for edittin is not fully functional.

Extract Regulation:

CellDesigner extracts the interactions where the Species regulates or is regulated by
other Species, from process diagram, and displays its block diagram.

1.
2.

Modifications/Activations Relation:

Open the dialog to check and edit Cdc2 Protein property (See. 3.1).
Click “edit block diagram” button and you can see the diagram as shown below.

= e b Ly cnne b Probeecl de ¥

B B O EE O e
PD@ROE M

— i — — — — i | o (B 2y

Xl

At the top side of the rectangle placed in center,
states of modification residues of Cdc2 and
proteins that cause change of the states
(phosphorylate or dephosphorylate) are shown.
At the left and bottom sides, binding to
CyclinB enzymic activity to Lamina are shown
respectively.

For notation details of the block diagram, see
Kitano (Biosilico 1, No.5 (2003) pp.169—176) .

List in the dialog shows all the Species of Cdc2
and Complexes with other Species in process
diagram (column) and their modfication states
and enzymic activity (row).

You can edit logical relation between modification states and enzymic acitivity.

1. Select the symbol “&” and then place them on the diagram.
2. Select the arrow, then link “P”, “&”,”’0” and “a”.

[To delete a placed symbol, select the symbol and press X button in the toolbar.]
The arrows represent causal relationship and “&” , “|”, etc. are logical operators.

Created logical relation can also be verified by checking consistency with contents of
process diagram.

3.

Press “verify” button.

16



CellDesigner™ Startup Guide

Enzymic activity fields inconsistent with edited logical relation are highlighted

in red.

e — | [ 2
|l B s O T O | B& & O

| & (T ) e S | B (T ) e

| — e —t — — — — | % [y | —t e — — — — | % [p S &

Caudd
A

Caudd
L

it

[*r]

wanl

wanl

Ty

2 | er = | = | o | |
= [ 1 1 [ ]
Hemar 1 1 1 [

The1d [l [] |
4 [l [] |
Trter G ]

1 1 1 [
Feamar I | [ ]

""-.M_-l-'n e

The above figures, the left is dipicted by logical relation innferred by Species s29
only and the enzimic activity field of Species s28 is highlighted. The right is

corrected by using the information of s28. (Note that the way of correction is not
unique.)
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4 Convenient Edit Functions

In this section, convenient functions for editing models are introduced.
CellDesigner prepares several functions that are generally seen in drawing software.

4.1 Temporal “select/move” mode

When constructing a model using buttons on toolbars to create new Species, Reactions,
and Compartments (in “create new“ mode), you cannot move any components unless
click the select/move icon. In model building, creating new components and layout
them are likely to be repeated successively. In such case, holding “s” key on your
keyboard down makes the current edit mode to “select/move” temporally. After moving
some components by drag, releasing the key makes the edit mode to “create new”

immediately.

Note: If you want to create components one by one, select “Input Repeat” in Edit menu
to OFF the checkmark.

4.2 Cut, Copy and Paste

In “select/move” mode, selected Species can be cut / copied to CellDesigner’s internal
clipboard by [CTRL]-x / [CTRL]-c, and pasted to the edit canvas by [CTRL]-v. The
copy-and-paste action makes “real” copies of the selected Species, which are
SpeciesAliases in CellDesigner’s terminology, referring the original Species. Strictly
speaking, all of the Species on edit canvas are SpeciesAliases referring each original
Species. By this feature, CellDesigner has multiple copies of the same Species on an
edit canvas (i.e. a model), to possess ability to make various expression of a network.

al process expression on the network diagram

as

GDP G afy

aliazes an alias aliases

guantitative substances in the <listOfSpecies=>

Fig. The Alias Structure of the CellDesigner
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4.3 Grouping

In “select/move” mode, by clicking multiple Species while holding the SHIFT key down,
you can make a temporal group of the selecting Species. Moving, cutting, and copying
them in a group are available. If you want the group to be permanent (saved to SBML),
use [CTRL]-g while the temporary group is formed. This grouping feature is
resembled to the situation, Species on a Compartment, while it has nothing to do with
structure of the model. Therefore, if these two conflict each other in the canvas,
“Species on a Compartment” structure has priority.

4.4 Set Grid Snap ON/OFF

Snapping components on grid makes it easier to layout the pathway diagram.
Try the followings from Edit menu.

*  Set Grids Size...

* Grid Snap

e Grid Visible

4.5 Zoom IN/OUT, Bird’s Eye View

You can change the zoom of the display by clicking the following icons.

[HE S0 x

When you create a big model, it would be convenient
to use the Bird’s Eye View to navigate inside the
model. The Bird’s Eye View can be displayed by
clicking the right most icon of the above tool bar.
When you click the position you want to display in
the Bird’s Eye View, you can move to the specified
position.

4.6 Change Color and Shape

x| You can change the color and shape of the
frevee Species and Compartments individually or
their default settings.

[ Size

\hickh |53 Height |31

‘ [ ‘ To change the default settings of the color and
T I shape, select the Preference menu.
& color To change the color and shape of the individual

Colar

components, select the components to edit, and
then select the icon of Change Color & Shape

Swatches | wse | roe|

% | in the tool bar.

Restore Default | Apply | OK | Cancel
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4.7 Display special characters in Component name

As CellDesigner is compliant to SBML, all names of components in a model must be
conforming to the SBML convention. CellDesigner 2.0 is now compliant to SBML
Level 2 Version 1; any character that can be mapped to UTF-8 encoding can be used
for the component names. If you want the special characters, such as + plus, line

break, superscript and subscript, you should follow the special rules to input such
characters.

Examples:

A special character is expressed by a sequence of characters with precedent and follow
up '_'s. Here are some examples:

1) Ca2+ ("Ca" with "2+" superscript)

=
*Ca_super_2_plus__endsuper_ { G agy ] { E:é:l;;linﬁ ]

* Ca_super_2+_endsuper_

2) G alpha beta gamma ("G" with Greek "aBy" subscripts)
*G_sub__alpha_ beta_ gamma__endsub_
*G_sub_aBy_endsub_

3) Complex of Cdc2 and CyclinB ("Cdc2" followed by "+CyclinB" in the new line).
*Cdc2_br__plus_CyclinB
*Cdc2_br_+CyclinB

For more details on displaying special characters, check “Name Expression” at Help
menu.

Caution: CellDesigner uses the "name" attributes as information to distinguish

Species. Therefore, even if the rendered names look the same, the different "name"
attributes, for example, "Ga" and "G_alpha_", mean different Species.
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5 Simulation

In this section, how to simulate a model is described.

CellDesigner can be used as a kind of SBML file editors for simulators.
There are two ways to conduct the simulation by CellDesigner:
* using Simulation menu to call SBML ODE Solver seamlessly. The conditions cab be
set using the Control Panel directly.
* using SBW menu to call SBML compliant simulators.

Simulation menu SBW menu
for direct control over SBML ODE Solver to call SBML compliant simulator.

If you select Simulation menu, you can call SBML ODE Solver directly. The ControlPanel
enables you to specify the details of parameters, changing amount, conducting parameter
search, and interactive simulation with intuitive manner.

If you select SBW menu, you can pass the SBML data from CellDesigner to the SBML
compliant simulators via SBW. You can conduct simulation seamlessly from CellDesigner
via SBW to evoke such SBML compliant simulators.

Note: You need to set up SBW before you conduct simulation.

To conduct time evolving simulation, you also need to know some basics of the SBML
specification. Here in this document, describes the minimum requirements for simulation.
See also:

For more details on SBML Level 1 specification, please check
http://sbml.org/specifications/sbml-level-1/version-2/sbml-level-1-v2.pdf

For SBML Level 2 specification, see
http://sbml.org/specifications/sbml-level-2/version-1/sbml-level-2.pdf
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5.1 Simulate a model by using Control Panel

1. Open a SBML model to simulate.
2. Select “Simulation” - “Control Panel” menu.
The simulation control panel will be displayed.

3. In the control panel, click [Execute] button.
You will see the time course plot in the right side of the control panel.
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Lo - ¥ Corcertration faw =] I Speces [ Fues [ Pawwelers [ Covpwivents o] S0 | Cokor
Lred Tiven 100=] S g 'Wh
=] Esprent R -,‘_I 128 Jere
M, of Forts 100 F oxa Bl
“n = F o
Speciet | Parameters | Change smourt | Farameter Soan | vierl <0 "0 g ::::
M| heme | | ety Type] wam oy
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See also:
For more details on how to use control panel, please refer to the document “Running

CellDesignerTM Simulation with ControlPanel’ in the /documents directory.

5.2 Setup for Simulation via SBW

Before you start simulation, you need to check if the SBW and SBW-powered
simulator modules have been installed in the path mentioned in Section 1.2 “Install

SBW and SBW Modules”.
1. To check if the SBW is properly installed, start CellDesigner and open a model.

SBW menu in the main menu is enabled if your setup has correctly been done.

2. Check if there are any simulators listed in the SBW menu.
If you have installed the simulators of your choice correctly, they are listed under

SBW menu. The following is the SBW menu in typical environment on Windows.

Typical SBW menu

¢ Simulation Service
¢ Save Model as Matlab ODE Function File
¢ Save Model as Matlab SimuLink Function File
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¢ Jarnac Simulation Service

"Simulation Service" appears if Jarnac has been installed. The others are
default-installed.

5.3 Simulate a model via SBW

Try simulation with a sample file:
1. Open simulation.xml in "samples" directory.
2. Choose Simulation Service from SBW menu.
This wakes Jarnac up and gives the model simulation.xml to it.
3. Check the help or manual of the simulator to learn how to start the simulation.

5.4 Data required for Simulation

From side of SBML model building, you should specify first at least some Species and
its attributes, and Reaction and its attribute for simulation. The minimum
requirement of their attributes might be:

*Species: -initialAmount (default=0.0),

*Reaction: -reactant: -SpeciesReference: -stoichiometry (default=1),
-product: -SpeciesReference: -stoichiometry (default=1),
-kineticLaw: -formula,

-parameter,

where the rightmost of each line is required to be input.

Species Attributes

The attribute “initialAmount” should usually be changed to a positive value.

The attribute “formula” should be text string according to SBML Level 1 specification,
probably including id (name in SBML Level 1) attribute of Species and parameters
defined by the attribute “parameter.” These attributes can be set at the Species list
shown in the List Area.

Reaction Attributes

The attributes and parameters of the Reaction can be specified at the Reaction dialog

and their child dialogs.

1. Open and see simulation.xml in samples directory.

2. Check the Reactions list in the List Area to see how the kinetic laws and
parameters are specified.

For the other parameters required, the default values specified in SBML Level 1 are
used.
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6 Symbols and Expressions

In this section, symbols for building models with CellDesigner are listed. Graphical
notation and listing of the symbols are based on proposal by Kitano
(http://www.sbw-sbml.org/workshops/sixth/sbmlsbwstockholm.htm). The symbol system
for state-transition diagram and the residue state representation among the proposal are
almost realized with CellDesigner.

6.1 Basic Symbols
6.1.1 Species

There are twelve types of Species symbols.

Species activated
protein Generic

Protein

protein Receptor

Receptor

protein Ion channel
|

protein truncated

=)
)
[ F
a
T )
.
1
)

|

3

L

=
.

T

AT

!

Fikey— e

ene
g Gene

RNA

Anti-sense RNA

A b A
phenotype Phenotype

simple molecule

o
T

6.1.2 Modifications of Protein Residues

There are seven types of symbols for residue modification states. The residue
symbols accompanied with their label (used for residue name and position in
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amino acid sequence) can be attached to all protein-type Species.

Phosphorylated E
Protein
Acetylated
[:|]} Protein
Ubiquitinated
Frotein
Methylated
{ Protein
Hydroxylated
@' Frotein
Empty E
Protein
Don’t Care
FProtein
Unknown
FProtein

6.1.3 Compartment

There are ten types of Compartment symbols. For each type, the thick line
indicates outside of its boundary.

Square

Oval

Compartment_Oval

Close-up type i~ = Northwest, Northeast
Southwest, Southeast
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S

Close-up type || || West, East
—_— North, South

6.1.4 Reaction

There are thirteen types of Reaction symbols.

Reactions
State Transition -
A —m= |
Known Transition Omitted l Abbreviated symbol
A "" B of several Reactions
Unknown Transition
Ab---- = B
Transport i
A —I= B
Catalysis
y a

Unknown Catalysis . E
A
l?-
Inhibition _ B
Unknown Inhibition E
T

Add Reactant e
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Add Product

Heterodimer Association

Dissociation

Dissociation of
Proteins by
truncation.

Truncation

Transcriptional Activation

Transcriptional Inhibition

Translational Inhibition

Translational Activation _4»_@
Modifier

MadificationLink
Product Reactant
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6.2 Expressions

Here are symbols acquiring additional semantics by shape, combination of symbols, or
change in drawings. Active t the Species is active.

Active P .

I
a
=4
@
=
by
|
.
I
Tr AR
[
e ——

Channel Open Activate Ion_Channel.
lol el
Homodimer Double-click the Species to open
formed 5 l the identity dialog, then set the
Homodimer number.

Heterodimer [ C'}."C”FIB J
formed CyclinB
Thr14
Ce2 Teps ClC2 Tt
Hypothetical i ; Double-click the Species to open
Species | hypothetical | the identity dialog, then check
Fiopgmpr e o J the hypothetical ON.

Reversible B Double-click the Reaction, then
Reactions set “reversible” to “true”
Bidirectional B Simply draw two state
Reactions ! transitions and reposition them
Homodimer R Click the icon of Homodimer
formation I formation.
Degradation of ' Click the icon of Degradation.
Species A ’

[ — ‘: H i

i s | s s s E

! E rd rid :1

name,and L. o .
class(-symbol type)  2tve homodimer=2 min sum;dtfiﬁu;aliun
;'osphnmmd
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7 Limitations and Known Issues

7.1 Limitations

(a) Available actions of UNDO and REDO are limited to actions making change on the
draw canvas.

(b) Regarding Heteromultimer:
As CellDesigner adopts the alias structure (as described Section 4.2 “Cut, Copy and
Paste”), any heteromultimer created out of SpeciesAliases is regarded as a new
SpeciesAlias. Therefore, the attributes specified to the individual components
(SpeciesAliases) will not be maintained in the newly created heteromultimer.
Once the heteromultimer is being created, you can no longer edit the individual
components of the heteromultimer. To edit the individual component, you should
release the heteromultimer, and edit them, then re-create them as a new
heteromultimer.

7.2 Known Issues

(a) The problems are reported in printing / exporting images of the huge model due to
the lack of the memory.
(b) When using CellDesigner in non-English environment on MacOSX and Linux,
letters on dialog boxes from File menu are not correctly displayed.
¢ For MacOSX, open “System Preferences” and click “International” icon from
“Personal” row, and then click “Language” tab. In the window for choosing
language, place “English” at the top. (Note: The terms quoted by “_“depend on
your environment.) Then start CellDesigner.
¢ For Linux, unset LANG in the shell, then starts CellDesigner.
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